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Preface 

The User's Guide explains the utility MegaRAID Storage Manager™ to be used for “LSI Logic 
Embedded MegaRAID(tm)”, “N8103-91 Disk Array Controller(Internal SAS HDD)”, “N8103-90 
Disk Array Controller(External SAS HDD)” , “N8103-99 Disk Array Controller(0ch)” , 
“N8403-019 Disk Array Controller” and “LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) 
ROMB”,  installed in NEC Express5800 server. 

The guide is intended for persons who are familiar with Windows functions and operation methods. 
For details on or unclear points on Windows operation, see Windows Online Help and manuals. 

When using MegaRAID Storage Manager™, first read the User's Guide provided with the server as 
well. 
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1. Overview 

1.1 MegaRAID Storage Manager™ 
MegaRAID Storage Manager™ (hereafter abbreviated for MSM) is an application that locally or 
remotely monitors and manages the MegaRAID Storage Systems(SAS/SATA).  

MegaRAID Storage Systems(SAS/SATA) are following systems. 

• LSI Logic Embedded MegaRAID(tm) 

• N8103-90 Disk Array Controller(External SAS HDD) 

• N8103-91 Disk Array Controller(Internal SAS HDD) 

• N8103-99 Disk Array Controller(0ch) 

• N8403-019 Disk Array Controller 

• LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) ROMB 

MSM has the following features: 

 Flexible system management 

MSM provides a system using MSM with N-to-1 management. In the environment 
enabling communication through TCP/IP, more than one system can be managed at a time 
by remote management. 

 Feature of creating or deleting the following arrays (packs) on the graphical operation 
screen 

MSM allows the following arrays to be created: 

 RAID 0 (data striping with more than one hard disk drive) 

 RAID 1 (data mirroring with two hard disk drives) 

 RAID 5 (Data and parity striping with more than two hard disk drives) 

 RAID 1 spanning (Same as RAID10. Data mirroring and striping with more than three 
hard disk drives) 

 RAID5 spanning (Same as RAID50. Data striping including parity and striping with 
more than five hard disk drives) 

IMPORTANT:  
Support RAID Levels depends on MegaRAID Storage 
Systems(SAS/SATA). Please check Section "4.1 Supported 
function of MegaRAID Systems". 

 

 Check consistency feature for checking array consistency 

MSM supports the check consistency feature for checking consistency. MSM also supports 
the feature of recovering data automatically if the check consistency feature detects 
inconsistency. 
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 Auto array rebuild feature in array degrading 

MSM supports the hot-spare rebuild executed at the insertion/removal of a disk and the 
hot-spare rebuild in which a hot-spare disk is defined previously and used at the shift of the 
array to degrading state. 

NOTE: The hot-swap rebuild is available only in a system 
supporting hot-swap. 

To start MSM, more than 255 colors must be selected in the screen setup. If only up to 255 colors are 
selected, the popup requesting more than 255 colors appear and MSM cannot be started. 
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2. Installing and Uninstalling MSM 

2.1 MSM Operation Environment (Server Specification) 
The following shows the hardware and software operation environment (sever specification) 
required to operate MSM: 

 Hardware 

 Server: NEC Express5800/50,100,600 series server supporting following MegaRAID 
Storage Systems(SAS/SATA). 

• LSI Logic Embedded MegaRAID™ 

• N8103-90 Disk Array Controller(External SAS HDD) 

• N8103-91 Disk Array Controller(Internal SAS HDD) 

• N8103-99 Disk Array Controller(0ch) 

• N8403-019 Disk Array Controller 

• LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) ROMB 

 Remaining capacity in hard disk drive: 60MB or larger 

 Software (It depends on which OSs are supported in each computer.) 

 Windows Server 2003 SP1 (32bit/64bit) 

 Windows Server 2003 R2 (32bit/64bit) 

 Windows XP Professional SP2 (32bit) 

 Windows XP Professional x64 Edition 
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2.2 Installing and Uninstalling MSM in Server 
This section describes the installation and uninstallation of MSM in an NEC Express5800 series 
server equipped with the MegaRAID controller. 

IMPORTANT:  
Only users authorized as administrators are permitted to 

install and uninstall MSM. 

As premised, the software must be supported by Server. 

Windows Security Warning is shown about "POPUP" as the 
case may be, when installing the MSM. This POPUP 
module is disabled in the installer of MSM, so there is no 
problem. This warning is not shown after the rebooting, 
anymore. 

The dialogue of "warning of security" is sometimes indicated 
to installation of a "Stanby/Hibernation Lock" driver at 
the time of installation of MSM. When our warning was 
indicated, Please choose "Yes." and continue installation. 

 

NOTES: 
Installation of MSM in server of custom installation model 

For some servers of the custom installation model, MSM 
may previously be installed at their purchases. 

Setup of server by Express Setup 
MSM can be installed by using "Express Setup", 
automatic installation tool stored in the NEC 
EXPRESSBUILDER CD-ROM coming with the 
purchased server. If you start the seamless setup, the 
dialog box appears which allows you to specify the 
desired application. Then select "MSM". 

Install the MSM manually with the CD which attached the 
SAS Card, when there is no MSM installer in the  
"EXPRESSBUILDER" CD. 
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2.2.1 Installing MSM to Server 

Install MSM in the following procedure: 

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of your computer. 

2. Right-click [Software Setup] in the [Master Control Menu] appearing on the screen and 
click [MegaRAID Storage Manager]. Then the [Selecting Installation or Uninstallation] 
dialog box appears. Select [Installation for MSM] and click [Next]. 

 

 

3. The [Specifying Installation Destination Directory] dialog box appears. If you want to 
change the installation destination folder, click [Browse], and follow the instructions in the 
dialog box that appears. If the directory is specified completely, click [Next]. If the 
installation destination directory may not be changed, click [Next] without change. 
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4. The installation is started. When MSM has been installed, the [Setup finished] dialog box 
appears. 

Select [Yes, I want to restart my computer now], and click [OK]. 

 

NOTE: After selecting system reboot at the termination of 
MSM installation, the background of the setup may remain 
as it is, rarely. If this occurs, follow the procedure below: 

(1) Press Ctrl + Alt + Delete and start the Task Manager 
on the [Windows Security] screen. 

(2) Terminate the [InstallShield - MSM] task. 

(3) If a dialog such as "1628: Script-base installation could 
not be completed" appears, click [OK] to close the 
dialog box. 

Then reboot the system to complete the installation. Despite 
the operation, MSM has been installed normally. 
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2.2.2 Uninstalling MSM from Server 

Uninstall MSM in the following procedure: 

IMPORTANT:  
Do not uninstall MSM through [Add or Remove 

Applications] or [Add or Remove Programs] in the 
Control Panel. Always follow the procedure described in 
this section for the uninstallation. 

The popup for warning as “Application is not running”, when 
uninstalling the MSM. Close this popup for warning, 
there is no problem. 

 

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of your computer. 

2. Right-click [Software Setup] in the [Master Control Menu] appearing on the screen and 
click [MegaRAID Storage Manager]. Then the [Selecting Installation or Uninstallation] 
dialog box appears. Select [Uninstallation for MSM] and click [Next]. 

 
3. After a while, the [Uninstallation Confirmation] dialog box appears. Click [Yes]. 

 
4. Uninstallation of MSM starts. The [Setup Finished] dialog box appears when MSM has 

been uninstalled. Select [Yes, I want to restart my computer now], and click [OK]. 
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2.3 MSM Operation Environment (Management PC) 
The following shows the hardware and software operation environment (management PC 
specification) required to operate MSM: 

 Hardware 

 PC: 
NEC Express5800/50,100,600 series. 
PC/AT compatible machine (equipped with Intel PentiumⅢ CPU or higher) 

 Remaining capacity in hard disk drive: 60MB or larger 

 Software 

 Windows Server 2003 SP1 (32bit/64bit) 

 Windows Server 2003 R2 (32bit/64bit) 

 Windows 2000 SP4 (Server/WorkStation) 

 Windows XP Professional SP2 (32bit) 

 Windows XP Professional x64 Edition 

 

2.4 Installing and Uninstalling MSM in Management PC 
This section describes the installation and uninstallation of MSM in a PC managing servers through 
a network. 

IMPORTANT: Only users authorized as administrators are 
permitted to install and uninstall MSM. 

 

NOTES: 
For some servers of the custom installation model, MSM 

may previously be installed at their purchases. 

Install the MSM manually with the CD which attached the 
SAS Card, when there is no MSM installer in the  
"EXPRESSBUILDER" CD. 
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2.4.1 Installing MSM to Management PC 

Install MSM in the following procedure: 

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of your computer. 

2. Run MSM.EXE contained in the following folder: 

\MSM\VIVA\MSM.EXE 

3. The screen shown below appears. Click [Next]. 

 
4. The screen shown below appears. Check [I accept the terms in the license agreement] and 

click [Next]. 

 
5. The screen shown below appears. Check [All users] and click [Next]. 
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6. The screen shown below appears. Click [Next]. 

To change the installation folder, click [Change] and specify a new installation folder. 

 
7. The screen shown below appears. Select [Client] and click [Next]. 

 
8. The screen shown below appears. Click [Install]. 

 
9. The screen shown below appears. Click [Finish]. 

 
Now the installation is completed. 
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2.4.2 Uninstalling MSM from Management PC 

Uninstall MSM in the following procedure: 

IMPORTANT:  
Do not uninstall MSM through [Add or Remove 

Applications] or [Add or Remove Programs] in the 
Control Panel. Always follow the procedure described in 
this section for the uninstallation. 

 

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive of your computer. 

2. Run MSM.EXE contained in the following folder: 

\MSM\VIVA\MSM.EXE 

3. The screen shown below appears. Click [Next]. 

 
4. The screen shown below appears. Check [Remove] and click [Next]. 
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5. The screen shown below appears. Click [Remove]. 

 
6. The screen shown below appears. Click [Finish]. 

 
Now the uninstallation is completed. 
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3. Operation 

This chapter describes how to start MSM and how to operate MSM. 

The supported features of  MSM are depended on MegaRAID Storage Systems(SAS/SATA). 
Unsupported features are not shown in the MSM menu. See also Section "4.1 Supported function of 
MegaRAID Systems" for more details. 

 

3.1 Starting MSM 
This section describes how to start MSM. 

IMPORTANT: 
Terminate the MSM display in other than array maintenance 

operation. 

Depending on the OS and/or color scheme you use, the 
screens appearing actually may be different from those 
shown in this manual. 

 

NOTE: If MSM is installed in a computer in which OS 
supporting Windows firewall is installed, the "Important 
warning on Windows security" window may appear against 
"javaw" at the start of MSM. If this occurs, select [Release 
block]. 
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3.1.1 Controlling MegaRAID Storage System with Local/Remote 
Computer 

To control MSM with local and/or remote computers, start MSM in the following procedure to 
display the array configuration screen. 

NOTES: 
To control MSM with a remote computer, MSM must also be 

installed in the remote computer. 

MSM services must operate in any systems controlled by 
remote computers. 

If the firewall feature provided by Windows OS operates in a 
system controlled by a remote computer, MSM cannot be 
controlled by the remote computer. 
In the situation, change the setting so that MSM can be 
controlled by the remote computer. 

 * MSM uses ports 3071 and 5571. MSM also uses any 
port numbers 32000 over temporarily. Do not block 
these ports. 

1. Select [Start] → [Programs] →  [MegaRAID Storage Manager] and click [StartupUI]. 

 
2. Select the server to be controlled by local and/or remote computers and click [Connect]. 

 
MegaRAID Storage Systems(SAS/SATA) belonging to a specific subnet are automatically 
displayed as candidates. For connection extending over the subnet, enter the IP address in 
the text box at the bottom of the screen and click [Update]. If a MegaRAID Storage system 
is found in the server of the specified IP address, the result will be reflected on the display. 
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A circle icon appears on each host in the server selection screen. The host status is shown 
by one of the following colors: 

Green: Normal operation 

Yellow: Occurrence of disk array degrading 

Red: Occurrence of configuration error 

3. Operate the following on the login screen. 

 
 In the [Login Mode] field, select [Full Access] to change the array configuration or 
[View Only] to see the configuration only. 

 In the [User name] field, specify the name of a user authorized as an administrator for 
the system. 

 In the [Password] field, type the password of the user specified in the [User name] 
field. 

 Click [Login]. 

NOTES: 
If [Full Access] is selected, only a single can log in to the 

system. 

If [Full Access] is selected, only a user authorized as an 
administrator can log in to the system. 

The names of login users and their IP addresses are recorded 
in the MSM log. 

 

IMPORTANT: 
Only local users can be specified with an Administrators 

authority in the [User name] field. Domain users can not 
login MSM as Administrators, regardless of their 
authorities. 
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3.2 MSM Operation Screen 
An example of the MSM screen is shown below (after logged in, the screen shown below appears). 

 
MSM has four screen interfaces as follows: 

(1) Menu bar 

(2) Physical/Logical View 

(3) Properties/Operations/Graphical view 

(4) Event Viewer 

The following operations are permitted for the above interfaces: 

 A feature can be selected from the menu bar. 

 On the Physical/Logical View, an object can be selected. Further, an item on the object 
can be selected by right-clicking the object. 

 On the Operations tab, a feature can be selected. 

 On the Event Viewer, an event can be selected. Further, an item on the event can be 
selected by right-clicking the event. 

 The detailed information on an event can be displayed by double-clicking the event. 

NOTES: 
Any item grayed out in each menu is unavailable due to some 

reason in the environment in which the menu is displayed. 

An available menu item changes with the MegaRAID 
Storage system that you're using it. 

 

(1)

(2) (3)

(4)
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3.2.1 Menu Bar 

Selectable objects on the menu bar can also be selected/executed by right-clicking them. 

The menu bar appears as follows: 

 
The menus are described below. 

 [File] menu 

On the [File] menu, you can select the following items. 

 
[Rescan]: 

Rescan the arrays to acquire the array configuration information again. 

[Exit]: 

Exit from MSM. 

IMPORTANT: To do the rescan operation again, the interval 
from the previous scan should be 60 sec or longer. If the 
interval is shorter, an unexpected event may occur. 

 [Operations] menu 

When you select the [Operations] menu, the menu displayed by right-clicking an object 
specified on MSM appears. The [Operations] menu changes depending on the focusing 
object. 

 [Group Operations] menu 

On the [Group Operations] menu, you can select the following items: 

 
[Check Consistency]: 

Execute the consistency check for logical drives. See Section "3.4.1 Executing Check 
Consistency" for the consistency check. 

[Initialize]: 

Initialize logical drives. 

[Show Progress]: 

Allows you to check the progress of the process being executed or abort the process. 
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 [Log] menu 

On the [Log] menu, you can select the following items: 

 
[Save Log]: 

Save the logs appearing in the Event Viewer to the specified file. 

[Clear Log]: 

Clear the logs appearing in the Event Viewer. 

[View Saved Log]: 

Allow you to view the logs saved in file with [Save Log]. 

 [Tools] menu 

This menu is not supported. Do not use the features on this menu. 

 [Help] menu 

On the [Help] menu, you can select the following items: 

 
[Help]: 

Indicate the help information. 

But this information is not maintained. So please see this online manual instead of 
[Help]. 

[About]: 

Indicate the version information on MSM. 
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3.2.2 Physical/Logical View 

On the Physical/Logical View, the physical and logical drives connected to the disk array controller 
are displayed in the tree format, respectively. 

If you put the cursor on a displayed object and right-click the object, then you can select and run an 
available feature. Menu displayed by right-clicking is called “Context Menu”. The contents of 
“Context Menu” depend on the available MegaRAID Storage Systems(SAS/SATA). 

 Menu displayed by right-clicking Controller [Context Menu]: 

The following shows a sample menu which may be displayed by right-clicking the 
Controller. 

 
[Enable Alarm]: 

Enable the alarm feature. 

The alarm beeps if a fault occurs in the disk array controller. The alarm continues until 
you select [Silence Alarm] described later. 

[Disable Alarm]: 

Disable the alarm feature. 

With the alarm feature disabled, the alarm does not beep if a fault occurs in the disk 
array controller. 

[Silence Alarm]: 

Stop the alarm if it beeps. 

[Start Patrol Read / Stop Patrol Read]: 

Start/stop the Patrol Read feature. 

The screen display varies depending on the execution status of the Patrol Read feature. 

[Advanced Operations] → [Configuration] 

→ [Configuration Wizard]: 

Create a logical drive. See Section "3.3.1 Creating Logical Drive" for how to create a 
logical drive. 

→ [Add Configuration from file]: 

Recover the saved configuration. 

→ [Save Configuration]: 

Save the configuration in a hard disk drive or floppy disk. 

→ [Clear Configuration]: 

Clear the information on the disk array configuration. 
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[Scan For Foreign Config]: 

Read configuration info from HDD and try to rebuild array by using that info. 

This feature is not supported. Do not use the feature. 

 

 Menu appearing when right-clicking physical drive [Context Menu] : 

The menu appearing when right-clicking Physical Drive varies depending on the status of 
the physical drive. Sample menus are shown below in physical drive states. 

When physical drive operates normally: 

 
[Make Drive Offline]: 

Make the physical drive offline. 

This feature is dedicated for maintenance. Do not use the feature. 

[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 

 

When physical drive is being rebuilt: 

 
[Abort Rebuild]: 

Aborts the rebuild processing. 

[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 
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When physical drive is in offline status: 

 
[Make Drive Online]: 

Makes the physical drive online. 

The feature is dedicated for maintenance. Do not use the feature. 

[Mark Physical Drive as Missing]: 

This feature is not supported yet. Do not use the feature. 

 

[Rebuild]: 

Starts the rebuild processing. 

[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 

 

When physical drive is hot-spare disk: 

 
[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 

 [Remove Hotspare]: 

Releases the setting as a hot-spare disk. 
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When physical drive is not used yet: 

 
[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 

 [Make Global Hotspare]: 

Create a Global hot-spare disk. 

[Prepare For Removal]/ [Undo Prepare For Removal]: 

Do not use the feature. It's the function which stops and restarts a revolution of a 
spindle motor of HDD, but these are the operation which has no need in particular in 
an HDD exchange. 
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 Menu appearing when right-clicking Virtual Disk [Context Menu] : 

The menu appearing when right-clicking Virtual Disk varies depending on the status of the 
logical drive. Sample menus are shown below in logical drive states. 

When logical drive operates normally: 

 
[Delete Virtual Disk]: 

Select this feature to delete the logical drive. 

[Locate Virtual Disk]: 

Start to blink LED of Physical disks consists of Virtual disk. 

[Stop Locating Virtual Disk]: 

Stop to blink LED of Physical disks consists of Virtual disk. 

[Check Consistency]: 

Check the consistency of the logical drive. 

[Advanced Operations] 

→ [Reconstruction Wizard]: 

Increases in the capacity of the existing array or changes the RAID level. 

See Section "3.7.1 Executing Reconstruction" for how to execute the reconstruction. 

IMPORTANT: When you use "N8103-90" with "N8141-37", 
order of HDD on MSM disagree with order of HDD on 
"N8141-37". In this case, "Locate Virtual Disk" feature can 
help. 
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When logical drive is degraded: 

[Check Consistency] disappears to be unavailable while it is displayed if the logical drive 
operates normally. 

When logical drive is subject to consistency check or rebuild processing: 

 
[Delete Virtual Disk]: 

Select this feature to delete the logical drive. 

[Locate Virtual Disk]: 

Start to blink LED of Physical disks consists of Virtual disk. 

[Stop Locating Virtual Disk]: 

Stop to blink LED of Physical disks consists of Virtual disk. 

[Cancel Check Consistency] (only in consistency check): 

Cancel the consistency check. 
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3.2.3 Properties /Operations/Graphical View 

The Properties/Operations/Graphical view indicates the information on controllers and drives 
selected in the Physical/Logical View in the Properties view, the setups/executions of available 
features in the Operations view, and the capacities of graphical drives in the Graphical view. 

 Properties 

Indicate the information on selected controllers and drives. 

 Operations 

Allows you to set or execute features available for the selected controllers and drives. 

IMPORTANT: Setup/execution of feature 

In the setup/execution of a feature on the Operations view, 
select the desired feature from the menu shown to the left, 
change the setting on the window shown to the right if 
necessary and select [Go]. 

The menu displayed in the Operations view varies depending on the states of the selected 
objects and/or drives. Sample menus are shown below. 

When controller is selected: 

 
[Enable Alarm]: 

Enable the alarm feature. 

[Disable Alarm]: 

Disable the alarm feature. 

[Silence Alarm]: 

Stop the alarm when it beeps. 

[Flash Firmware]: 

Update the firmware of the controller. 

This operation is dedicated for maintenance. Do not use the feature. 

[Set Patrol Read Properties]: 

Allow you to set the Patrol Read schedule. See Section "3.5.2 Scheduling Patrol Read" 
for the schedule setting. 
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[Start Patrol Read / Stop Patrol Read]: 

Start or stop the Patrol Read. 

The screen display varies depending on how the Patrol Read is executed. See Section 
"3.5.1 Manual Execution of Patrol Read" for the execution of the Patrol Read. 

[Set Adjustable Task Rates]: 

Specify the preferential assignment of the system processing capacity with a value 
between 0% and 100% when the rebuild, Patrol Read, or check consistency feature is 
executed. Specifying a higher value allows the system processing capacity to be used 
more preferentially. Specifying a lower value causes the system performance during 
rebuild to remain only in a lower level. This only sets the priority against other 
processes. With 0%, the feature can also operate. Similarly, With 100%, any other 
processes are not always interrupted. 

 

When physical drive is selected (in normal state): 

 
[Make Drive Offline]: 

Make the physical drive offline. 

This feature is dedicated for maintenance. Do not use the feature. 

[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 
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When physical drive is selected (under rebuild processing): 

 
[Abort Rebuild]: 

Abort the rebuild processing. 

[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 

 

When physical drive is selected (in offline status): 

 
[Make Drive Online]: 

Make the physical drive online. 

This feature is dedicated for maintenance. Do not use the feature. 

[Mark Physical Drive as Missing]: 

This feature is not supported yet. Do not use the feature. 

[Rebuild]: 

Start the rebuild processing. 

[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 
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When physical drive is selected (being hot-spare disk): 

 
[Remove Hotspare]: 

Release the setting as a hot-spare disk. 

[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 

 

When physical drive is not used yet: 

 
[Locate Physical Drive]: 

Start to blink LED of Physical disk. 

[Stop Locating Physical Drive]: 

Stop to blink LED of Physical disk. 

 [Make Global Hotspare]: 

Create a Global hot-spare disk. 

[Make Dedicated Hotspare]: 

Create a hot-spare disk operating only for the specified array. 
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[Prepare For Removal]/ [Undo Prepare For Removal]: 

Do not use the feature. 

It's the function which stops and restarts a revolution of a spindle motor of HDD, but 
these are the operation which has no need in particular in an HDD exchange. 

 

When logical drive is selected (in normal state): 

 
[Delete Virtual Disk]: 

Select this feature to delete the logical drive. 

[Locate Virtual Disk]: 

Start to blink LED of Physical disks consists of Virtual disk. 

[Stop Locating Virtual Disk]: 

Stop to blink LED of Physical disks consists of Virtual disk. 

[Check Consistency]: 

Check the consistency of the logical drive. 

[Start Initialization]: 

Initialize the logical drive. 

[Set Virtual Disk Properties]: 

Allows you to set the read and/or write policies of the logical drive. 

 

When logical drive is selected (in degrading or under rebuild processing): 

[Check Consistency] and [Start Initialization] is disabled (removed from the menu) in the 
above screen. 
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When logical drive is selected (in execution of consistency check): 

 
[Delete Virtual Disk]: 

Select this feature to delete the logical drive. 

[Locate Virtual Disk]: 

Start to blink LED of Physical disks consists of Virtual disk. 

[Stop Locating Virtual Disk]: 

Stop to blink LED of Physical disks consists of Virtual disk. 

[Cancel Check Consistency]: 

Cancel the consistency check. 

[Set Virtual Disk Properties]: 

Allows you to set the read and/or write policies of the logical drive. 
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 Graphical View 

Indicate the capacity of the selected drive graphically. 

The following shows the sample displays of physical and logical drives. 

Sample display of physical drive 

If you select a logical drive from the [Select Virtual Disk (VD)] list as shown to the left in 
the figure below, you can check the area in which physical drives are used for the selected 
logical drive as shown to the right in the figure. 

 
<When no logical drive is selected> <When logical drive is selected> 

 

Sample display of logical drive 
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3.2.4 Event Viewer 

The Event Viewer indicates the log information acquired in the period from the time at which the 
server is started. 

 
 Right-click the Event Viewer. 

 
[Save Log]: 

Save the logs appearing in the Event Viewer to the file. 

[Clear Log]: 

Clear the logs appearing in the Event Viewer. 

[View Saved Log]: 

Allow you to view the logs saved by selecting [Save Log]. 

NOTES: 
There are two type of logs on MSM log viewer. 

2006-04.24. xx:xx:xx :             "Actual time" 
xxxxxx seconds from reboot :  "Progress time since rebooting" 

 
MSM logs are registered by following rules. 
- Events which occurred after to finish OS started are shown as "Actual    
time" 
- Events which occurred before to finish OS starting are shown as "Progress 
Time". 
Check the application logs of system event logs, if you want to know 
"Progress time" as "Actual time". 

"Date/Time" of log is sometimes shown by the MegaRAID Storage system 
that you're using to "Actual time" by "Progress time since rebooting". 
Please confirm the date and time by application log in this case. 
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3.3 Creating and Deleting Logical Drive (Array) 
The creation method of a logical drive and the deletion method are explained here. If  you create 
logical drives, do not reuse failure HDDs. Please always use new HDDs. 

MSM allows the following logical drives to be created: 

 RAID 0 (data striping with more than one hard disk drive) 

 RAID 1 (data mirroring with two hard disk drives) 

 RAID 5 (Data striping including parity with more than two hard disk drives) 

 RAID 1 spanning (Same as RAID10. Data mirroring and striping with more than three 
hard disk drives) 

 RAID 5 spanning (Same as RAID50. Data striping including parity and striping with 
more than five hard disk drives) 

NOTES: 
Do not use the following hard disk drives to create a logical 

drive. 

 – Hard disk drive with partitions 

 – Hard disk drive used for another array 

While a logical drive is created, system shutdown and 
insertion/removal of a hard disk drive are not permitted 
till the creation process is completed. 

Available RAID level depends on MegaRAID Storage 
System. Please check "4.1 Supported function of 
MegaRAID Systems"for more detail. 
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3.3.1 Creating Logical Drive 

You can create a logical drive on the Configuration Wizard appearing by right-clicking the controller 
in the Physical/Logical View and clicking [Advanced Operations] → [Configuration] → 
[Configuration Wizard]. 

 
As the configuration type, you can select any of Auto Configuration, Manual Configuration or 
Guided Configuration. 

 
[Auto Configuration]: 

The auto configuration mode allows the draft of the logical drive configuration to be 
created automatically depending on the status of unused hard disk drives. 

[Manual Configuration]: 

The manual configuration mode allows a logical drive to be created according to a 
specific request. 

[Guided Configuration]: 

The guided configuration mode allows a logical drive to be created by specifying 
setting items sequentially. 

The selection buttons commonly displayed on the logical drive creation screen are as 
follows: 

[Cancel]: Cancels the logical drive creation process. 
[Back]: Returns to the previous sheet. 
[Next]: Goes to the next sheet. 
[Finish]: Creates a logical drive. 

The following sections describe the logical drive creation procedures in different 
configurations. 
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3.3.1.1 Auto Configuration 

The auto configuration mode allows the draft of the logical drive configuration to be created 
automatically depending on the status of unused hard disk drives. 

The setting procedure is described below. 

1. Click [Auto Configuration] in [Mode Selection] of the Configuration Wizard. 

 
2. The array configuration draft is created automatically. 

For redundant array configuration, select [With Redundancy] in [Redundancy Type]. 

To edit the array configuration, click [Modify]. 

The menu appearing at the selection of [Modify] is the same as that in Step 3 of the manual 
configuration. See Step 3 in the manual configuration for how to change the setting. 

 
Initialization Type 

[No Initialization]: 

Do not initialize the logical drive after it is created. Do not specify this option. 

[Fast Initialization]: 

Do Simple initialization. This option initialize the management information of array, 
only. 

[Full Initialization]: 

Initialize the logical drive after it is created, completely. Always use this option, if you 
could. 
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Redundancy Type 

[No Redundancy]: 

Do not provide redundant array configuration. 

[With Redundancy]: 

Provide redundant array configuration. 

 

3. Click [Finish] to create a logical drive. 

 

3.3.1.2 Manual Configuration 

The manual configuration mode allows a logical drive to be created according to a specific request. 

The setting procedure is described below. 

1. Click [Manual Configuration] in the [Mode Selection] of the Configuration Wizard. 

 
2. Select a physical drive from the Unconfigured Physical Drive List and click the  

button to add the physical drive to the Arrays with Available Space. 

To recover the added physical drive, select the physical drive and click the  button. 

 
[Add Hotspare To]: 

Set the physical disk as the hot-spare disk operating only for the specified array. 

[Remove HotSpare]: 

Release the setting as the hot-spare disk. 

3. Click [Accept]. Then click [Next]. 
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4. Set parameters in Virtual Disk Properties appropriately and click [Accept]. Then click 
[Next]. 

 
[RAID Level]: 

Select the RAID level of the array. 

[Size (in MB)]: 

Set the capacity of the logical drive to be created. 

[Volume ID]: 

Leave the initial setting value unchanged. 

[Volume Name]: 

Specify the name of the logical drive. 

[Stripe Size]: 

Select the unit of data distributed to each hard disk drive configuring RAID out of 8K, 
16K, 32K, 64K, and 128K bytes. The default setting is 64K bytes. 

LSI Logic Embedded MegaRAID(tm) is always 64K bytes. 

[Read Policy]: 

Select No Read Ahead, Adaptive Read Ahead, or Always Read Ahead. The default 
setting is No Read Ahead. 

[Default Write Policy]: 

Select either Write Through or Write Back. The default setting is Write Back. 

Do not change this setting on "LSI Logic Embedded MegaRAID(tm) ". 

NOTES: 
A check box of "Use Write Through for failed or missing 
battery" was added to [Default Write Policy] since 
MSM1.14-02. The default value of "Use Write Through for 
failed or missing battery" is the checked state when you 
specify "Write Back" in [Default Write Policy]. Please set 
the unchecked state in this case. Even if there is a battery 
(iBBU), it will be "Write Trough" in the checked state. 
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[IO Policy]: 

Select either Direct IO or Cached IO. The default setting is Direct IO. 

[Access Policy]: 

Select Read Write, Read Only, or Blocked. The default setting is Read Write. 

[Disk Cache Policy]: 

Select Unchanged, Enabled or Disabled. The default setting is Unchanged. 

 

 

[Init State]: 

Select the logical drive initialization procedure out of No Initialization, Fast 
Initialization and Full Initialization. The default setting is No Initialization. 

NOTE: Depending on the disk array controller you use, 
some setting values may be restricted for stable system 
performance and operation. 
Refer to manuals coming with the Disk array controller and 
server for the settings previously. 

5. Check the contents of the array to be configured. 

After checking the contents, click [Finish]. Then the logical drive is created. 
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3.3.1.3 Guided Configuration 

The guided configuration mode allows a logical drive to be created by specifying setting items 
sequentially. 

The setting procedure is described below. 

1. Click [Guided Configuration] in the [Mode Selection] of the Configuration Wizard. 

 

 

2. Select [Redundancy] and [Existing Arrays] options and specify the number of logical 
drives to be created in [Desired Number of Virtual Disks]. Click [Next]. 

 

 

Redundancy 

[Redundancy Only]: 

Create redundant array configuration. 

[Redundancy when possible]: 

Try to create redundant array configuration. If not possible, creates non-redundant 
array configuration. 

[No Redundancy]: 

Create non-redundant array configuration. 

Existing Arrays 

[Use Existing Arrays Only]: 

Use existing arrays only. 
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[Don’t use Existing Arrays]: 

Do not use existing arrays. 

[Use Existing and New Arrays]: 

Use both existing and new arrays. 

 

3. Specify the number of logical drives to be created for each RAID and its capacity in Virtual 
Disk Count and Total Capacity, respectively. Set relevant parameters in Virtual Disk 
Properties and click [Next]. 

 
[Stripe Size]: 

Select the unit of data distributed to each hard disk drive configuring RAID out of 8K, 
16K, 32K, 64K, and 128K bytes. The default setting is 64K bytes. 

LSI Logic Embedded MegaRAID(tm) is always 64K bytes. 

[Read Policy]: 

Select No Read Ahead, Adaptive Read Ahead, or Always Read Ahead. The default 
setting is No Read Ahead. 

[Default Write Policy]: 

Select either Write Through or Write Back. The default setting is Write Back. 

[IO Policy]: 

Select either Direct IO or Cached IO. The default setting is Direct IO. 

[Access Policy]: 

Select Read Write, Read Only, or Blocked. The default setting is Read Write. 

[Disk Cache Policy]: 

Select Unchanged, Enabled or Disabled. The default setting is Unchanged. 
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[Init State]: 

Select the logical drive initialization procedure out of No Initialization, Fast 
Initialization and Full Initialization. 

The default setting is No Initialization. 

NOTE: Depending on the disk array controller you use, 
some setting values may be restricted for stable system 
performance and operation.Refer to manuals coming with 
the Disk array controller and server for the settings 
previously. 

 

4. Check the contents of the array to be configured. 

After checking the contents, click [Finish] to create the logical drives. 

To edit the array configuration, click [Modify]. 

The menu appearing at the selection of [Modify] is the same as that in Step 3 of the manual 
configuration. See Step 3 in the manual configuration for setting changes. 

 
 

3.3.2 Deleting Logical Drive 

You can delete a logical drive in the following procedure: 

1. Select the logical drive to be deleted in the Logical view. 

2. Click [Operations] → [Delete Virtual Disk] on the menu bar. 

3. A confirmation/warning message appears. Select [Yes]. Selecting [No] causes the deletion 
processing to be canceled. 

4. The selected logical drive is deleted from MSM. 

IMPORTANT: Any logical drive deleted by mistake cannot 
be recovered any more. Before deleting a logical drive, make 
sure that it may be deleted. 
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3.4 Check Consistency Feature 
The check consistency feature checks consistency and automatically corrects data if some 
inconsistency is detected. 

IMPORTANT: The Check Consistency function and the Patrol Read 
function allow you to find the defects (due to degradation such as aging) in 
files of low access frequency and unused areas as soon as possible. In 
rebuilding after replacement of a HDD due to a failure, subsequent defects 
may be found in remaining HDDs. In such a case, the system cannot be 
recovered. Thus, detecting subsequent defects as early as possible is 
extremely effective as preventive maintenance. Periodical synchronization 
or media patrol is effective to keep the stable operation of your system. It is 
strongly recommended to take the action once per week or at least once per 
month. 

 

3.4.1 Executing Check Consistency 

The check consistency is executed in the following procedure. 

 

Check consistency execution procedure 

The check consistency can be executed in any of the following three ways. 

 Starting execution on menu bar 

 Starting execution on menu displayed by right-clicking 

 Starting execution on [Operations] tab 

The execution procedures in the ways are described below. 

 

Starting execution on menu bar 

1. Select [Group Operations] → [Check Consistency] on the menu bar. 
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2. Check one or more logical drives to be subject to the check consistency in [Select Virtual 
Disks] and click [Start]. 

 
[Select All]: 

Check all logical drives. 

[Deselect All]: 

Uncheck all logical drives. 

3. The check consistency check is executed. 

Click the [×] button at the upper right corner of the screen to close it. 

Select [Group Operations] → [Show Progress] on the menu bar to see the progress of the 
execution. 

Starting execution on menu displayed by right-clicking 

1. Select a logical drive on the [Logical] tab and right-click it. 

2. Select [Check Consistency] on the menu displayed by right-clicking. 

 
3. The consistency check is executed. 

Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the 
execution. 
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Starting execution on [Operations] tab 

 
1. Select a logical drive on the Logical view and select the [Operations] tab. 

2. Check [Check Consistency] and click [Go]. 

3. The consistency check is executed. 

Select [Group Operations] → [Show Progress] on the menu bar to see the progress of the 
execution. 
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3.4.2 Canceling Check Consistency 

The check consistency can be cancelled in the following procedure. 

 

Check consistency canceling procedure 

1. Select [Group Operations] → [Show Progress] on the menu bar. 

2. The Group Show Progress screen appears. 

Click [Abort] to the right of the progress indication. 

 
[Abort All]: 

With more than one logical drive being subject to the check consistency, allows the 
check consistency to be canceled for all the logical drives 

3. Cancels the consistency check. 

Click the [×] button at the upper right corner of the Group Show Progress screen to close it. 
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3.5 Patrol Read Feature 
The Patrol Read feature operates in physical drives configuring all arrays including hot-spare disks 
to detect errors and recover the system from the errors if they are detected. 

IMPORTANT: The Check Consistency function and the Patrol Read 
function allow you to find the defects (due to degradation such as aging) in 
files of low access frequency and unused areas as soon as possible. In 
rebuilding after replacement of a HDD due to a failure, subsequent defects 
may be found in remaining HDDs. In such a case, the system cannot be 
recovered. Thus, detecting subsequent defects as early as possible is 
extremely effective as preventive maintenance. Periodical synchronization 
or media patrol is effective to keep the stable operation of your system. It is 
strongly recommended to take the action once per week or at least once per 
month. 

 

3.5.1 Manual Execution of Patrol Read 

The Patrol Read can be executed manually in the following procedure. 

 

Patrol Read execution procedure 

1. Under the selection of a controller on the Physical/Logical View, click [Operations] → 
[Start Patrol Read] on the menu bar. 

 

 

2. If the confirmation dialog shown below appears, click [Yes]. 

The Patrol Read is executed. 
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To interrupt the Patrol Read being executed, click [Operations] → [Stop Patrol Read]. 
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3.5.2 Scheduling Patrol Read 

The Patrol Read can be scheduled in the following procedure. 

 

Patrol Read scheduling procedure 

1. Select a controller on the Physical/Logical View. Then select [Operations] . 

2. Check [Set Patrol Read Properties]. 

3. The schedule setting screen shown below appears. Change the Operation Mode to [Auto]. 

If [Auto] is selected already, the mode change is not required. 

 
[Auto]: 

Execute the Patrol Read scheduling. 

[Manual]: 

Disables the execution of the scheduled Patrol Read and enables the manual execution 
only. 

[Disabled]: 

Disable the Patrol Read. 

4. Change the following items to desired values and click [Go]. 

[Maximum PD Count for patrolling]: 

Set the maximum number of physical drives for which the Patrol Read is to be 
executed. 

Do not change the default value (255). 

[Continuous Patrolling]: 

This feature is not supported yet. Do not check it. 

[Select Excluded Virtual Disks]: 

If you check one or more logical drives appearing in this item, the Patrol Read is not 
executed for the drives. To execute the Patrol Read for all logical drives, do not put 
checks in this option. 
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[Execution Frequency]: 

Specify the interval at which the Patrol Read is executed. 

You can set the interval in hours, minutes, or seconds. 

NOTES: 
If you shutdown the server on the way of manual Patrol Read, 

it is aborted. Execute the Patrol Read again when the 
server is started. 

If you shutdown the server on the way of schedule Patrol 
Read, it will be restarted from the beginning at the next 
start of the server. 
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3.6 Rebuild Feature 
The rebuild feature can recovers a degraded array. Before the feature can be used, the defected hard 
disk drive must be replaced with a normal hard disk drive. 

The rebuild can be done in the following three ways. 

 

[Hot-swap rebuild]: 

This method provides rebuild by replacing a hard disk drive defected during system operation with a 
normal hard disk drive. 

 

[Hot-spare rebuild]: 

This method previously creates a hot-spare disk and starts rebuild by using the spare disk 
automatically when a hard disk drive is defected. 

Hot-spare disks include the following two types. 

 Global Hot-spare 

Hot-spare disks of the type are used to operate for all arrays. 

 Dedicated Spare 

Hot-spare disks of the type are used to operate for specified arrays. 

 

[Rebuild from MSM]: 

The feature starts rebuild by selecting [Rebuild] displayed by right-clicking the defected hard disk 
drive. Because the feature uses the defected hard disk drive to try array recovery, the rebuild may fail 
or the array may be degraded immediately after it can be recovered. 

Accordingly, it cannot secure the operation after the rebuild. 

The hot-swap and hot-spare rebuild operations are described below. 

NOTES: 
Do not use the hot-swap feature during array rebuild 

operation. 

To enable rebuild, the disk capacity of the new hard disk 
drive should be equal to or larger than the disk capacity of 
the defected hard disk drive. 
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3.6.1 Hot-swap Rebuild 

The feature can be done in the following procedure: 

1. Find the defected hard disk drive. The following figure shows a sample display in MSM. 

 
The icon shows a degraded logical drive. The icon shows a defected hard disk 
drive. 

2. Pull out the defected hard disk drive. 

3. Insert a normal hard disk drive into the slot from which the defected hard disk drive is 
pulled out. After the insertion, the rebuild operation is started. 

 
The icon shows the hard disk drive being rebuilt. 

Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the 
execution. 

IMPORTANT: For the replacement of a hard disk drive by 
using the hot-swap feature, the interval from the removal of 
the defected hard disk drive to the installation of a substitute 
hard disk drive should be 60 sec or longer. A shorter interval 
may cause an unexpected event to occur. (It is recommended 
to go to the next step after the removal and installation can be 
recognized on MSM.) 
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3.6.2 Hot-spare Rebuild 

3.6.2.1 Hot-spare Disk Setting Procedure 

Global hot-spare setting procedure 

1. Specify an unused hard disk drive shown on the Physical view and right-click it. 

2. Select [Make Global Hotspare] in the menu displayed by right-clicking. 

3. The hard disk drive is shown to be a hot-spare disk. 

 

Dedicated hot-spare setting procedure 

1. Select an unused hard disk drive shown on the Physical view. Then select [Operations]. 

2. Check [Make Dedicated Hotspare]. 

3. The array selection screen shown below appears. Check the array to be operated 
dedicatedly in Select array and click [GO]. 

 

IMPORTANT: As a hot-spare disk, use a drive having a 
capacity larger than or equal to that of the hard disk drive 
configuring the array. If the hard disk drive has only a lower 
capacity, the hot-spare build feature cannot be operated. 

3.6.2.2 Release of Hot-spare Disk Setting 

1.  Select a hot-spare disk and right-click it. 

2. Select [Remove Hotspare] from the menu displayed by right-clicking the hot-spare disk. 

3. The confirmation message appears. Select [Yes]. If you select [No], the release processing 
is cancelled. 

4. The hot-spare disk setting is released. The released disk will be an unused hard disk drive. 
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3.7 Reconstruction Feature 
The reconstruction feature allows you to increase in the capacity of an existing array and/or change 
its RAID level. 

IMPORTANT: 
Execution of reconstruction 

It is recommended that the partitions on a logical drive are 
always backed up before the addition of the capacity of 
the array so that proper measures can be taken at the 
occurrence of an unexpected event. 

Any reconstruction cannot be cancelled after it is started. 
 

NOTE: The reconstruction feature is only available only 
under the following condition: 

Only a single logical drive should be configured in the array 
(the reconstruction feature is unavailable if more than one 
logical drive are configured in the array). 

 

3.7.1 Executing Reconstruction 

To execute the reconstruction, right-click the relevant logical drive on the Logical view, click 
[Advanced Operations] → [Reconstruction Wizard] and select [Yes] for the confirmation message 
shown below to display the Reconstruction Wizard. 

 

 
The Reconstruction Wizard can also be displayed by selecting the relevant logical drive on the 
Logical view and clicking [Operations] → [Advanced Operations] → [Reconstruction Wizard] on 
the menu bar. 
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The reconstruction is divided into three types; Add Drive, Remove Drive and Change RAID Level. 

 
[Add Drive]: 

Add a physical drive to the logical drive to increase in the capacity of the array. 

[Remove Drive]: 

Removes the physical drive from the logical drive and converts the RAID level to 
RAID 0. 

[Change RAID Level]: 

Convert the RAID level to RAID 0. 

The reconstruction procedures in types are described below. 

 

3.7.1.1 Add Drive 

This feature adds a physical drive to the logical drive to increase in the capacity of the array. 

The procedure is described below. 

1. Click [Add Drive] in Reconstruction Mode of the Reconstruction Wizard. 
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2. Select the physical drive to be added from the upper list and click the  button to move 
the physical drive to the lower list. Then click [Next]. 

 
3. The physical drive to be added appears with red characters. Select the RAID level after the 

expansion from [New RAID Level] and click [Finish]. 

 
4. The confirmation message appears. Select [Yes]. If you select [No], the Add Drive feature 

is cancelled. 

 
Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the 
execution. 

IMPORTANT: Specify only a single HDD in the execution 
of Add Drive. If more than one HDD must be specified, first 
complete the addition of a single HDD and then start the Add 
Drive feature again. 
 
"Add Drive" feature increase capacity of array, but do not 
increase capacity of partition which recognize by OS. If you 
want to increase partition size, you need to make partition 
newly after "Add drive".  It is recommended that the 
partitions on a logical drive are always backed up before 
remake partitions. 
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3.7.1.2 Remove Drive 

This feature removes the physical drive from the logical drive and converts the RAID level to RAID 
0. The procedure is described below. 

1. Click [Remove Drive] in Reconstruction Mode of the Reconstruction Wizard. 

 
2. Select the physical drive to be removed from the upper list and click the  button to move 

the physical drive to the lower list. Then click [Next]. 

 
3. The physical drive to be removed appears with red characters. After checking the 

information, click [Finish]. 

 
4. The confirmation message appears. Select [Yes]. If you select [No], the Remove Drive 

feature is cancelled. 

 
Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the 
execution. 
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3.7.1.3 Change RAID Level 

This feature converts the RAID level to RAID 0. 

The procedure is described below. 

1. Click [Change RAID Level] in Reconstruction Mode of the Reconstruction Wizard. 

 
2. Select RAID 0 from New RAID Level and click [Finish]. 

 
3. The confirmation message appears. Select [Yes]. If you select [No], the Change RAID 

Level feature is cancelled. 

 
Select [Group Operations] → [Show Progress] on the menu bar to know the progress of the 
execution. 
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3.8 Help 
Selecting [Help] → [Help] on the menu bar allows the help normally attached to MSM to be 
displayed. 

NOTE: The help normally attached to MSM includes the 
features unsupported by the NEC Express5800 series 
machines and the features on array boards unsupported by 
the NEC Express5800 series servers. See the relevant 
descriptions in this manual for the supported features. 

 

Version confirmation procedure 

Selecting [Help] → [About] on the menu bar allows you to see the MSM version. 

If you select [Server Info], the information on the server appears as shown below. 

   
<When [About] is selected> <When [Server Info] is selected> 
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4. Miscellaneous Information 

4.1 Supported function of MegaRAID Systems 
Supported function of MSM depends on the MegaRAID Systems. See below for detail. 

Remarks 
MegaRAID Systems 

Embedded MegaRAID:   LSI Logic Embedded MegaRAID(tm) 

N8103-90:                       N8103-90 Disk Array Controller(External SAS HDD) 

N8103-91:                       N8103-91 Disk Array Controller(Internal SAS HDD) 

N8103-99:                       N8103-99 Disk Array Controller(0ch) 

N8403-019:                     N8403-019 Disk Array Controller 

ROMB:                            LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) ROMB 

√ : Supported. 
MegaRAID Systems 

Function (*1) Embedded 
MegaRAID N8103-90/91 N8103-99 N8403-019 ROMB 

Menu Bar √ √ √ √ √ 

Physical/Logical View √ √ √ √ √ 

Properties/Operations/Graphical 
View √ √ √ √ √ 

Operation of 
GUI 

Events Viewer √ √ √ √ √ 

Supported Array Level (*2) 
0, 1, 10 

0, 1, 10, 

5, 50 

0, 1, 10,  

5, 50 
0, 1 

0, 1, 10, 

 5, 50 

Making & Delete Logical Drives √ √ √ √ √ 

Check Consistency √ √ √ √ √ 

Manual Operation  √ √ √ √ Patrol Read 

Scheduled Operation   √ √ √ √ 

Hot Swap Rebuild √ √ √ √ √ Rebuild 

Hot Spare Rebuild √ √ √ √ √ 

Global Hot Spare √ √ √ √ √ Hot Spare 

Dedicated Hot Spare  √ √ √ √ 

Physical 
Disk 

Locate Physical Drive  √ √ √ √ 
Locate Virtual Disk  √ √ √ √ Logical Disk 

Reconstruction Wizard  √ √ √ √ 

Alarm  √ √   

Flash Firmware  √ √ √ √ 

Browse & Save Logs √ √ √ √ √ 

Misc. 

Remote Function √ √ √ √ √ 

*1 : Depends on RAID driver or RAID firmware. 
*2 : Depends on Server. 
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4.2 How to confirm the type of Hot Spare Disks 
You could confirm the type of Created Hot Spare Disks by MSM. 

There are 2type of Hot Spare Disk, "Global Hot Spare Disk" and "Dedicated Hot Spare Disk". 

How to confirm 

• Global Hot Spare Disk 

"Global Hot Spare Disk" is shown on Physical View, but not shown on Logical View. 

• Dedicated Hot Spare Disk 

"Dedicated Hot Spare Disk" is shown on both of Physical and Logical View. 

Sample 

1. Start up MSM. 

2. Show Physical View. Check Hot Spare Disk icon ( ). 

There are 2type of Hot Spare Disk, "Global Hot Spare Disk" and "Dedicated Hot Spare Disk" 
(marked red frame). 

 

3. Show Logical View. Check Hot Spare Disk icon ( ). There is only "Dedicated Hot Spare 
Disk" (marked red frame). 

 



CAUTIONS AND RESTRICTIONS  61 

 

5. CAUTIONS AND RESTRICTIONS 

5.1 Common Cautions and Restrictions for MegaRAID 
Storage Systems(SAS/SATA) 

 

Installing / uninstalling of MSM 

 MSM temporarily uses a dynamic port number (49152 or above) during installation. 
MSM automatically releases the port at the end of installation. 

 If MSM is installed in a computer in which OS supporting Windows firewall such as 
Windows XP is installed, the "Important warning on Windows security" window may 
appear against "javaw" at the start of MSM. If this occurs, select [Remove block]. 

 Windows Security Warning may be shown about “POPUP” when installing MSM. This 
POPUP module is disabled in the installer of MSM, so there is no problem. The warning 
message is no longer shown after system reboot. 

 The dialog of "warning of security" may be displayed during the process of 
"Standby/Hibernation Lock" driver installation at MSM installation. In this case, select 
"Yes" to continue the installation. 

 To control MSM by a remote computer, MSM must be installed in both local and remote 
computers. 

 Popuplog.log file is created in C: drive at the time of MSM installation. This file is not 
used after the reboot, so this file is able to remove after the reboot. 

 

MSM operation 

 MSM client can not be started until MSM related service completes a start. When having 
started a MSM client before starting service, the next error is indicated. 
    "Fatal Eror:Cannot connect to Framework!" 
MSM related service is the following. 
    - Service Name: MegaMonitorSrv,   Display Name: MRMonitor 
    - Service Name: MSMFramework,   Display Name: MSMFramework 

 If you select [Replace Missing Physical Drive] in [Operations], a pull-down menu 
without options appears in the right frame. Do not use the feature. 

  The firewall function which is provided by Windows OS disturbs the remote function of 
MSM. Change the setting for the remote function of MSM. Review the port setting for the 
firewall. 

 MSM uses port numbers 3071 and 5571. You cannot change these port numbers.  

 MSM uses any port numbers 32000 over temporarily. 

 Concurrent accesses by both MSMs in local and remote computers are possible. 
However, only a single MSM can have the full access authority. If the full access authority 
cannot be selected in the login mode, check whether an access from another client occurs. 
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The MSM log may be reviewed to see accesses from other clients. 

 You can specify the local users only as the Administrators member in the "User Name" 
field of MSM login window. You can not specify domain users which has Administrators 
right. 

 MSM cannot be used when there is no MegaRAID Storage System in the same LAN. 

 MSM  cannot be used when the target server has several ports which are belonged to 
different sub-net. In this case, please use MSM in the target server. 

 To do the rescan operation again, the interval from the previous scan should be 60 sec or 
longer. If the interval is shorter, an unexpected event may occur. 

 Do not use the "Prepare For Removal" and "Undo Prepare For Removal ". It is the 
function that stops and restarts a spinning of spindle motor of HDD, however, these are the 
operations which are no need in particular to replace HDDs. 

 A check box of "Use Write Through for failed or missing battery" was added to [Default 
Write Policy] since MSM1.14-02. The default value of "Use Write Through for failed or 
missing battery" is the checked state when you specify "Write Back" in [Default Write 
Policy]. Please set the unchecked state in this case. Even if there is a battery (iBBU), it will 
be "Write Trough" in the checked state. 

 

Creating or deleting logical drive 

 Specify the maximum capacity (default value) for RAID 1 spanning (RAID 10) or RAID 
5 spanning (RAID 50) if a logical drive is created with the capacity specified. Do not 
change the capacity. 

 In creation of a logical drive, do not use the following hard disk drives. 

• Hard disk drive with partitions 

• Hard disk drive used for another array 

  While a logical driver is being created, do not perform the followings:  

• Shut down the system 

• Insert hard disk drive(s) 

• Remove hard disk drive(s) 

 

Rebuild feature 

 Do not use the hot-swap feature during rebuild. 

 In the rebuild operation by using the hot-swap feature, the interval from the removal of 
the hard disk drive to the installation of a substitute hard disk drive should be 60 sec or 
longer. 

 Hard disk drives in the status shown below cannot be used as hot-spare disks. Instead, 
use new hard disk drives or hard disk drives already formatted. 

• Hard disk drive with partitions 

• Hard disk drive used for another array 
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Patrol Read feature 

 If the server is restarted, the Patrol Read feature is aborted. If you restart the Patrol Read 
after restarting the server, it will be executed from the first step. 

 Even when selecting "Stop Patrol Read" and making them suspend a patrol lead on the 
way, it indicates "Complete". 

 

Miscellaneous 

 It is recommended that "Check Consistency" or "Patrol Read" is periodically performed 
to detect defects due to the fails of HDDs. 

 Note that the icons of events reported by the NEC ESMPRO report feature are all 
displayed green on NEC ESMPRO (they seem information events). 

 If the [Save] dialog is displayed by selecting [Save Log] on the [Log] menu, the 
[Desktop] folder is displayed incorrectly in Japanese Environment. To save a log, specify 
a folder other than [Desktop]. 

 To start MSM, the screen setting should be done so that more than 255 colors are 
available. If only up to 255 colors are available, the relevant error message appears and 
MSM cannot be started. 

 If you display the dialog for [Save Log] and select [Detail], the information on [Type] 
will be garbled in Japanese environment. To check [Type] to be displayed in the save log 
operation, use Windows Explore. 

 When restarting MSM, the messages displayed in the MSM screen may disappear. Use 
the [Save Log] feature of MSM or check the messages registered in the Windows 
application log. 

 In case user wants to change the IP of the server system, MSMFramework Service needs 
to be restarted. 
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5.2 Cautions and Restrictions for N8103-90 Disk array 
controller(External SAS HDD) and N8103-91 Disk 
array controller(Internal SAS HDD) 

MSM Operation 

 "Date/Time" of MSM Logs is sometimes shown as "xx seconds from reboot". In this 
case, please check the Application Log of System Events. 

 Every time MSM is started when an additional battery (N8103-94) is not attached with, 
the next message is output by MSM log and event log (application). Even if Write Thru is 
set in Write Policy, this is output. 

 

 

 

 

 

 

 

 

 

 

 If redundant power unit is not installed to "N8141-37 Disk Expansion Unit", the 
following popup message may be shown up while installing MSM. And you may see the 
following event in MSM and application event logs at every boot time. However those are 
no problem. 

 

 

 

 

 

 When using N8141-37F Disk Expansion Unit which is connected to N8103-90F Disk 
Array Controller, it is necessary to check the slot numbers of drives before you use 
configuration wizard, rebuild feature or reconstruction feature. 

• The slot numbers are not displayed while executing the features and you need to select 
physical drive numbers of drives. Note that physical drive numbers which are displayed 
in the left panel of physical view may be different from the actual slot numbers of drives. 
You can see the slot numbers in the Properties view of drives on MSM such as the 
following copy of the screen. 

• The slot numbers are started from 0, although those printed on the unit are started from 
1. 

[ MSM Log ] 
  Controller ID:x BBU disables; changing WB logical drivers to WT. 
[ Event Log(Application) ] 
  Source :  MR_MONITOR 
  Event ID :   195 

* x is controller ID number. 
 
It can be restrained by this log printout's inputting `D' with the next message 
indicated at the time of a server start. 
 
The battery hardware is missing or malfunctioning, or the battery is 

unplugged.  If you continue to boot the system, the battery-backed cache 

will not function.  Please contact technical support for assistance. 

Press 'D' to disable this warning (if your controller does not have a battery). 

[ MSM Log ] 
Controller ID:x BBU disables; changing WB logical drivers to WT. 

[ Event Log(Application) ] 
Source :  MR_MONITOR 
Event ID :   173 
* x is controller ID number. 
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• To avoid selecting wrong drives, it is highly recommended to check them properly by 
executing ‘Locate Physical Drive’ or ‘Locate Virtual Disk’ operation on MSM. 
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5.3 Cautions and Restrictions for LSI Logic Embedded 
MegaRAID™ 

MSM Operation 

 MSM can not set "Virtual Disk Properties" for several "Virtual Disks" at the same time. 
If you want to set "Virtual Disk Properties" to the second Virtual Disk and all subsequent 
Disks, select "Rescan" to refresh the display. 

 "Progress display" and "HDD icon" cannot be updated automatically, when "Rebuild" is 
done by RAID10. Please use "Rescan" feature as workaround. 

 "Dedicated Hotspare" is not supported with MSM on "LSI Logic Embedded 
MegaRAID(tm)" environment, even if it is on the menu. 

 

Making & Removing of Logical Drives 

 When you make "Virtual Disk" by "Configuration Wizard", "Disk Cache Policy" is set to 
the value dependent on "Write Policy". 

 MSM can not delete "Virtual disk" during "Rebuilding" and "Checking Consistency". 

 Do not change "Default Write Policy" with " 

  

 Manual Configuration" or "
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 Guided Configuration". 

 

Miscellaneous 

 MSM logs are shown as GMT. The system event logs are shown correctly by local time. 
If you use the sort feature of MSM logs, restart MSM to display logs in order of time. 

  Task Rates is not supported. 

 When you change the name of "Virtual Disk", MSM display can not be refreshed. In this 
case, no message is registered. 

 When detecting an ECC error by "Check Consistency ", "Media Error Count" is not 
refreshed automatically. Please use "Rescan" in this case. 

 In the Windows XP 64bit environment, "Windows 2003" is displayed in the field of "OS 
name" in the server selection screen and property display on the MSM.  
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Appendix A Report Monitoring 

Event messages associated with the MegaRAID Storage system can be displayed on the NEC 
ESMPRO Manager. The setting varies depending on the environment as follows: 

 To monitor messages with the NEC ESMPRO Manager operating on a machine other 
than the server to which the monitored MegaRAID is connected, take the following 
procedure on the machine. 

 To monitor messages with the NEC ESMPRO Manager operating on the server to which 
the monitored MegaRAID is connected, no setup is required. 

 

Alert report registry setup procedure 

1. Insert the NEC EXPRESSBUILDER CD-ROM into the CD-ROM drive. If the [Master 
Control] menu appears on the screen, close the menu. 

Install the MSM manually with the CD which attached the SAS Card, when there is no 
MSM installer in the "EXPRESSBUILDER" CD. 

2. Start "MSMALTEN.EXE" in "\MSM\" of NEC EXPRESSBUILDER.  

Start "MSMALTEN.EXE" in "\MSM\", when you use the CD which attached the SAS Card, 
also. 

The confirmation dialog box appears. Select [Yes]. 

 
3. After the registry setup is completed, the dialog box indicating the termination appears. 

Click [OK] to reboot the system. 
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Alert report messages and actions against the messages 

If MSM is installed, the following messages registered as "MSM" are set as report targets. To change 
the setting, redefine it by the NEC ESMPRO Agent report setup procedure. 

To change the setting, redefine it by the NEC ESMPRO Agent report setup procedure. 

The event IDs in the table below are decimal numbers. Mark "√" in the Manager column indicates 
the transmission of the report to NEC ESMPRO Manager. Mark "√" in the Alive column indicates 
the transmission of the report to the express report service. Every report is sent as information.  

Event 
ID 

Message Action Mana
ger 

ALIVE

2 Unable to recover cache data 
from TBBU 

Replace the disk array controller. √ √ 

10 Controller cache discarded due 
to memory/battery problems 

Check the memory and battery. √ √ 

11 Unable to recover cache data 
due to configuration mismatch 

Replace the disk array controller. √  

13 Controller cache discarded due 
to firmware version 
incompatibility 

Replace the disk array controller. √  

15 Fatal firmware error: A firmware error occurs. Replace the disk 
array controller. 

√ √ 

17 Flash downloaded image 
corrupt 

The flash image may be damaged. Check 
the flash image. 

√  

20 Flash error Replace the disk array controller. √ √ 
23 Flash programming error Check the media used for flash. If the media 

are not defected, replace the disk array 
controller. 

√ √ 

24 Flash timeout during 
programming 

Check the media used for flash. If the media 
are not defected, replace the disk array 
controller. 

√ √ 

25 Flash chip type unknown Replace the disk array controller. √ √ 
26 Flash command set unknown Replace the disk array controller. √ √ 
27 Flash verify failure Replace the disk array controller. √ √ 
32 Multi-bit ECC error: If the error occurs frequently, take the 

preventive replacement of physical drives 
into account. 

√  

33 Single-bit ECC error: If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

34 Not enough controller memory Take the replacement of the disk array 
controller into account. 

√ √ 

46 Background Initialization 
aborted on VD: 

If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

47 Background Initialization 
corrected medium error: 

If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

49 Background Initialization 
completed with uncorrectable 
errors on VD: 

Take the preventive replacement of physical 
drives into account. 

√ √ 

50 Background Initialization 
detected uncorrectable multiple 
medium errors: 

Take the preventive replacement of physical 
drives into account. 

√ √ 

51 Background Initialization failed 
on VD: 

Take the preventive replacement of physical 
drives into account. 

√ √ 

56 Consistency Check aborted on 
VD: 

The consistency check is aborted. Check the 
validity. 
 

√  
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57 Consistency Check corrected 
medium error: 

If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

60 Consistency Check detected 
uncorrectable multiple medium 
errors: 

Take the preventive replacement of physical 
drives into account. 

√ √ 

61 Consistency Check failed on 
VD: 

Take the preventive replacement of physical 
drives into account. 

√ √ 

62 Consistency Check failed with 
uncorrectable data on VD: 

Take the preventive replacement of physical 
drives into account. 

√ √ 

63 Consistency Check found 
inconsistent parity on VD strip: 

If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

64 Consistency Check 
inconsistency logging disabled, 
too many inconsistencies on 
VD: 

If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

67 Initialization aborted on VD: If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

68 Initialization failed on VD: Take the preventive replacement of physical 
drives into account. 

√ √ 

75 Reconstruction stopped due to 
unrecoverable errors: 

If the error recurs, take the preventive 
replacement of physical drives into account. 

√  

76 Reconstruct detected 
uncorrectable multiple medium 
errors: 

If the error recurs, take the preventive 
replacement of physical drives into account. 

√  

79 Reconstruction resume failed 
due to configuration mismatch: 

If the error recurs, take the preventive 
replacement of physical drives into account. 

√  

82 PD Clear aborted: If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

83 PD Clear failed: If the error recurs, take the preventive 
replacement of physical drives into account. 

√ √ 

87 Error: Contact the support department. √  
90 Hot Spare SMART polling 

failed: 
Take the preventive replacement of physical 
drives into account. 

√ √ 

92 PD is not supported: Check whether a supported physical drive is 
inserted. 

√  

93 Patrol Read corrected medium 
error: 

If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

95 Patrol Read found an 
uncorrectable medium error: 

If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√ √ 

96 PD Predictive failure: Take the preventive replacement of physical 
drives into account. 

√ √ 

97 Puncturing bad block: If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√  

98 Rebuild aborted by user: The rebuild is aborted by some user 
operation. Build RAID again. 

√  

99 Rebuild complete on VD This message is rebuilding completion 
notification. The action is unnecessary. 

√ √ 

100 Rebuild complete on PD This message is rebuilding completion 
notification. The action is unnecessary. 

√ √ 

101 Rebuild failed due to source 
drive error: 

The source physical drive may be damaged. 
Take the replacement of the physical drive 
and the recovery from the backup into 
account. 
 
 

√ √ 
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102 Rebuild failed due to target 
drive error: 

The target physical drive may be damaged. 
Take the replacement of the physical drive 
into account. 

√ √ 

105 Rebuild started: This message is rebuilding starting 
notification. The action is unnecessary. 

√ √ 

106 Rebuild automatically started: This message is rebuilding starting 
notification. The action is unnecessary. 

√ √ 

107 Rebuild stopped due to loss of 
cluster ownership: 

Check the authority. √  

108 Reassign write operation failed: If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√ √ 

109 Unrecoverable medium error 
during rebuild: 

If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√ √ 

111 Unrecoverable medium error 
during recovery: 

If the error occurs frequently, take the 
preventive replacement of physical drives 
into account. 

√ √ 

119 SAS topology error: Loop 
detected 

Check the connection of the disk array 
controller. 

√ √ 

120 SAS topology error: Device not 
addressable 

Check whether the disk array controller is 
connected correctly. 

√ √ 

121 SAS topology error: Multiple 
ports to the same SAS address 

Check whether the disk array controller is 
connected correctly. 

√ √ 

122 SAS topology error: Expander 
error 

Check whether the disk array controller is 
connected correctly. 

√ √ 

123 SAS topology error: SMP 
timeout 

Check whether the disk array controller is 
connected correctly. 

√ √ 

124 SAS topology error: Out of route 
entries 

Check whether the disk array controller is 
connected correctly. 

√ √ 

125 SAS topology error: Index not 
found 

Check whether the disk array controller is 
connected correctly. 

√ √ 

126 SAS topology error: SMP 
function failed 

Check whether the disk array controller is 
connected correctly. 

√ √ 

127 SAS topology error: SMP CRC 
error 

Check whether the disk array controller is 
connected correctly. 

√ √ 

128 SAS topology error: Multiple 
subtractive 

Check whether the disk array controller is 
connected correctly. 

√ √ 

129 SAS topology error: Table to 
table 

Check whether the disk array controller is 
connected correctly. 

√ √ 

130 SAS topology error: Multiple 
paths 

Check whether the disk array controller is 
connected correctly. 

√ √ 

131 Unable to access device Check whether the disk array controller is 
connected correctly. 

√ √ 

134 Dedicated Hot Spare no longer 
useful for all arrays: 

Take the preventive replacement of physical 
drives into account. 

√ √ 

137 Global Hot Spare does not 
cover all arrays 

Take the preventive replacement of physical 
drives into account. 

√ √ 

140 VD Marked inconsistent due to 
active writes at shutdown: 

Check the consistency for confirmation. √  

145 Battery temperature is high The battery is heated at a high temperature. 
If the error occurs frequently, take the battery 
replacement into account. 

√ √ 

146 Battery voltage low If the error occurs frequently, take the battery 
replacement into account. 

√  

148 Battery is discharging If the error occurs frequently, take the battery 
replacement into account. 

  

150 Battery needs to be replaced, 
SOH Bad 

Replace the battery. √ √ 

154 Battery relearn timed out Replace the battery. √ √ 
162 Current capacity of the battery 

is below threshold 
If the error occurs frequently, take the battery 
replacement into account. 

√  
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166 Communication lost on 
enclosure: 

Check the connection of the enclosure. √ √ 

168 Fan failed on enclosure: Check the operation of the enclosure fan. √ √ 
170 Fan removed on enclosure: Check the connection of the enclosure fan. √ √ 
171 Power supply failed on 

enclosure: 
Check the power supply of the enclosure. √ √ 

177 Temperature sensor below 
warning threshold on enclosure: 

The temperature sensor exceeds over the 
warning threshold. Check the temperature. 

√  

178 Temperature sensor below error 
threshold on enclosure 

The temperature sensor exceeds over the 
error threshold. Check the temperature. 

√ √ 

179 Temperature sensor above 
warning threshold on enclosure 

The temperature sensor exceeds over the 
warning threshold. Check the temperature. 

√  

180 Temperature sensor below error 
threshold on enclosure: 

The temperature sensor exceeds over the 
error threshold. Check the temperature. 

√ √ 

181 Enclosure shutdown: Check the enclosure. √ √ 
182 Too many enclosures 

connected to port. Enclosure 
not supported: 

Decrease the number of connected 
enclosures. 

√  

183 Firmware mismatch on 
enclosure: 

The compatibility with the firmware of the 
enclosure is disabled. Contact the support 
department. 

√ √ 

184 Sensor bad on enclosure: Contact the support department. √  
185 Phy is bad on enclosure: The enclosure may be defected. Take the 

replacement into account. 
√ √ 

186 Unstable Enclosure: The enclosure may be defected. Take the 
replacement into account. 

√ √ 

187 Hardware error on enclosure: The enclosure may be defected. Take the 
replacement into account. 

√ √ 

188 No response from enclosure: The enclosure may be defected. Take the 
replacement into account. 

√ √ 

189 SAS/SATA mixing not 
supported in enclosure; 
disabled PD: 

SAS and SATA coexist in a specific 
enclosure. Check whether the connection is 
configured correctly. 

√  

190 Unsupported hotplug was 
detected on SES enclosure: 

The hot-plug is not supported. √  

195 BBU disabled; changing WB 
logical drives to WT 

Check the battery. √  

196 Bad block table is 80% full on 
PD: 

The bad block table in the physical drive is 
filled by 80% or larger. Replace the physical 
drive. 

√ √ 

197 Bad block table is full; unable to 
log block: 

The bad block table in the physical drive is 
full. Replace the physical drive. 

√ √ 

198 Consistency Check Aborted 
Due to Ownership Loss on VD: 

Check the authority. √  

199 Background Initialization (BGI) 
aborted due to ownership loss 
on VD: 

Check the authority. √  

200 Battery/charger problems 
detected; SOH Bad 

Replace the battery. √ √ 

201 Single-bit ECC error; warning 
threshold exceeded: 

Take the preventive replacement of the 
physical drive into account. 

√ √ 

202 Single-bit ECC error; critical 
threshold exceeded: 

Replace the physical drive. √ √ 

203 Single-bit ECC error; further 
reporting disabled: 

Replace the physical drive. √ √ 

204 Power supply switched off for 
enclosure: 

Check the power of the enclosure. √ √ 

206 Power supply cable removed on 
enclosure: 

Check whether the power cable of the 
enclosure is disconnected. 

√ √ 

211 BBU Retention test failed! Replace the BBU. √ √ 
214 NVRAM Retention test failed! Replace the disk array controller. √ √ 
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216 FAILED Test: The test detects an error. Take the 
replacement of the disk array controller into 
account. 

√ √ 

221 NVRAM is corrupt; reinitializing If the error occurs frequently, take the 
preventive replacement of the disk array 
controller into account. 

√  

222 NVRAM mismatch occurred If the error occurs frequently, take the 
preventive replacement of the disk array 
controller into account. 

√  

223 Link lost on SAS wide port: If the error occurs frequently, take the 
preventive replacement of the disk and disk 
array controller into account. 

√  

225 Allowed error rate exceeded on 
SAS port: 

If the error occurs frequently, take the 
preventive replacement of the disk and disk 
array controller into account. 

√  

226 Bad block reassigned: If the error occurs frequently, take the 
preventive replacement of the disk into 
account. 

√  

228 Temperature sensor differential 
detected on enclosure: 

If the error occurs frequently, take the 
preventive replacement of the enclosure into 
account. 

√  

229 Disk test cannot start. No 
qualifying disks found 

If the error occurs frequently, take the 
preventive replacement of the disk into 
account. 

√  

230 Time duration provided by host 
is not sufficient for self check 

If the error occurs frequently, take the 
preventive replacement of the disk array 
controller into account. 

√  

235 Firmware download failed on 
enclosure: 

If the error occurs frequently, take the 
preventive replacement of the enclosure into 
account. 

√  

236 Drive is not certified: Check the disk connection. √  
238 PDs missing from configuration 

at boot 
Check the disk connection. √  

239 VDs missing drives and will go 
offline at boot 

Check the disk connection. √  

240 VDs missing at boot Check the disk connection. √  
241 Previous configuration 

completely missing at boot 
Check the disk connection. √  

245 PD rebuild not possible as 
SAS/SATA is not supported in 
an array 

Check whether physical drives to be 
supported are used. 

√  

250 VD is now PARTIALLY 
DEGRADED 

Partial degrading is detected. Replace the 
defected physical drive and run the rebuild 
operation. 

√  

251 VD is now DEGRADED The logical drive is degraded. Replace the 
defected physical drive and run the rebuild 
operation. 

√ √ 

252 VD is now OFFLINE The logical drive enters into the offline 
status. Recover the data by using the 
backup. 

√ √ 

254 VD disabled because RAID-5 is 
not supported by this RAID key 

Please check the RAID key. √ √ 

255 VD disabled because RAID-6 is 
not supported by this controller 

Please check the RAID key. √ √ 

256 VD disabled because SAS 
drives are not supported by this 
RAID key 

Please check the SAS driver and the RAID 
key. 

√ √ 

257 PD missing Check the disk connection. √  
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